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�� 8VLQJ�WKLV�PDQXDO

Each section of the Procedure Guide has been arranged so that you can
extract or photocopy it for use by another member of staff. The individual
sections are identified in the small header text on each page.
The Contents page shows you the order in which information is presented
in this guide.
All menu option titles and field names in this guide are shown in bold, to
match the text you will see on screen.

G
Any field data displayed in the screen illustrations is for example
only; you should not copy it.

The Quick Checklists are itemised with a q - you might find it useful to
photocopy these lists and tick off each completed routine, until you are
confident that you know the software.
The alphabetical Index at the end of the guide refers you to all of the
functions, features, and detailed descriptions of the software.
The symbols used in this guide are:

I Stop - do not go any further without reading this paragraph.

< Back up your data before going any further.

4 A report should be generated at this point.

&37
Turn to the given page for further or linked information.

G
The following information is important - make sure you
understand before you go any further.

This Procedural Guide explains system setup in detail, then illustrates and
explains significant screens and provides an overview of the options
available, along with suggested routines for specific purposes. The Guide
only applies to users running Fundraising Pro under Windows95 and
Windows NT4.0. Macintosh users will find that this guide is very useful
since only cosmetic differences exist between Windows and Mac versions.

This Procedure Guide refers you to the separate User Guide where
information would otherwise need to be duplicated. This User Guide is itself
based on relevant extracts from the 4D manuals.



2



2

�� ,QWURGXFWLRQ�WR�)XQGUDLVLQJ�3UR
Fundraising Pro is an alumni and appeals database program, which is
useful to many different types of organizations who are tracking members,
former members or another constituency, with an eye to fundraising.  The
database consists of many tables which are automatically linked to facilitate
easy access to crucial data.  Report writes, graphing tools and import export
menus exist to make the data available in many formants.

��� )HDWXUHV

The software enables you to:

� Keep detailed records about your supporters and maintain contact  with
them.

� Customise a wide range of alphanumeric, date, and value fields in the
database, to suit your own requirements.

� Record donations. The British version make distinctions between
covenant, gift aid, direct gifts, pledges, gifts in kind, legacies and foreign
currency, and prepares appropriate tax forms.  The US version can
easily produce the appropriate form for the donor to fill out her or his tax
deduction.

� British tax claimers can automatically find anomalies, then calculate and
reclaim tax due on covenants and gift aid, on dates to suit your own
organisation.

� Create sets of popup boxes or choice lists to ensure that critical data is
entered accurately and in a standardised format.

� Import details from other database systems, for quick and accurate data
transfer.

� Set up your own definitions of group events (such as annual dinners) and
personal events (such as awards, or telephone conversations); link each
supporter to the appropriate events and thereby build up detailed
profiles.

� Use supporter profiles to target specific fundraising activity.

� Keep track of sponsors by recording and maintaining their preferences.
You can earmark donations -  either fully or partially - for a specific
purpose.

� Set up relationships between supporters’ records so that you can quickly
trace, for example, family links, or all supporters who are employees of a
particular company, or hold membership of a particular society.
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� Generate your own correspondence, forms and reports, either within the
package or by exporting data to a word processor or spreadsheet.

� Produce detailed financial projections and reports, charts or graphs;
standard layouts can be supplemented by your own customized reports.

� Track membership.

��� 'DWD�3URWHFWLRQ�/HJLVODWLRQ
You should ensure that your registration under the Data Protection Act
allows you to store and use the range of information which you plan to hold
in your Fundraising databases.

��� (QKDQFHPHQWV
If you need to report a possible fault, or request an additional feature to the
software, the procedure guide, or the on-line help, please send the details
to Stelias Computing Inc. who develop and maintain this product, or contact
your reseller.
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�� ,QVWDOODWLRQ��'DWDEDVH�)LOHV��/RJJLQJ�LQ
DQG�WURXEOHVKRRWLQJ

��� ,QVWDOODWLRQ

The installation of Fundraising Pro is discussed in the “Quick Tour” manual.
Here we will review what is actually installed. We assume that you have
chosen the standard option to install in the C:\frp directory.

The installation consists of many files, but only a few of these are of
importance.

����� 0XOWL�8VHU�,QVWDOODWLRQ
This topic is largely covered in the documentation coming with ACI’s 4D
Server.  Follow the instructions to install a 4D Server, using TCP/IP.

When this server is set up, run 4D Customiser to tune memory settings.
This is necessary for stability and performance of Fundraising Pro.

q Shutdown all 4D Clients and 4D Server software.
q Start 4D Customiser on each client (one at a time).
q Open 4D Client  with 4D Customiser.
q  Double click preferences
q Change the stack size to 512k  (it is 64k by default)
q Change the kernel memory to 15 blocks of 512k
q Change the cache size to 6000kb.
q  Close the preferences windows
q Quit and Save from 4D Customiser

Now repeat this on the server, to adjust the server settings:
q Shutdown all 4D Clients and 4D Server software.
q Start 4D Customiser on each client (one at a time).
q Open 4D Server  with 4D Customiser.
q  Double click preferences
q Change the stack size to 512k (it is 64k by default)
q Change the kernel memory to 15 blocks of 512k
q Change the cache size to 4096k on a small server (16MB) or to 10240k

on a larger server with 32MB or more.

If you receive messages indicating that the software is out of memory, do
the following:
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q Inform your supplier, indicating where in the program you received the
message.

q Start 4D Customiser on each client (one at a time).
q Open 4D Client  with 4D Customiser.
q  Double click preferences
q Increase the stack size by 256k

If the server displays an out of memory message, increase its stack size.

����� 'DWD�)LOHV
Data files must have an extension “.4dd”. If you charity is called
“Whalesaver” and appropiate name for your data file might be
“Whalesaver.4dd”.

Several demonstration data files are installed in the C:\frp\sample data
folder, where you can also find an Emptydata.4dd.  This is the starting point
for a new database.

After exploring the demonstration data files:

q Copy the emptydata.4dd to Whalesaver.4dd

q Place Whalesaver.4dd in the C:\frp\frpXXXs folder where XXX is the
version number of your product.

Make sure to make frequent backups of Whalesaver.4dd.  This is the file
that contains your entries in the database. Also before engaging in
operations which change large amounts of data (such as tax runs, imports,
applying formulas) back up the data file.

����� 7KH�SURJUDP�ILOHV

The program files for version XXX are located in the directory
n \frp\frpXXXs for single user versions
n \frp\frpXXXm for multi user installations

In single user installations you can find a copy of the executable program
and start it by clicking frpXXX.exe.  Multi-user installations cannot be started
without 4D Server.

Note that it is recommended that the data file to be kept in the same
folder. Don’t throw this folder away.
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����� 2WKHU�ILOHV�

A variety of other directories are created under C:\frp.  These are for
example:
n Sample data: contains empty and demonstration data files
n Reports: the recommended folder for Quick Reports
n Merges: the recommended place to store Mail merge letters and data

files
n Documentation: online copies of the documentation are stored here.

��� /RJJLQJ�LQ�DQG�VHOHFWLQJ�\RXU�GDWDEDVH

The following steps describe how you “link” Fundraising Pro to a particular
data file.  You will need to establish this link for example when:
1. You create your organization’s data file
2. You want to browse one of the demonstration files
3. You have moved the data file to a new location and you want to re-open

it.
4. You have compacted your database, or rebuilt it from tags for

maintenance or trouble shooting.

After establishing the “link” Fundraising Pro will open the same data file
when fired up again.

q Single user installations: Launch Fundraising Pro (FRP) from the Start
menu in the Programs, Fundraising Pro program group.

q When presented with the Login screen, select Administrator. DO NOT
PRESS OK yet.

q Hold down the Alt Key

q Now press OK with the mouse.

q In the file dialog which appears, select the data file (demodata.4dd,
whalesavers.4dd).

You may now be presented with the license screen where you can enter
your key if you have not already done so.

q In a multi-user set up, on the server workstation launch 4D Server
from the Start Menu.

q In the file open dialog box select C:\frp\frpXXX.4db. Do not press OK
yet. Here XXX is the version number of your product.

q Hold down the Alt-key when pressing OK
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q In the next file open dialog select the data file (demodata.4dd,
whalesavers.4dd)

q If your networking is set up correctly, you can now access the database
you selected by starting 4D Client from a client workstation.

q On the client workstation: log in as administrator. You may have to fill
out a license form if you have not already done so.

In the future when you start up Fundraising Pro, it should select the correct
database file for you.  You need not press the Alt-key which shortens the
process of starting up.

��� .HHSLQJ�\RXU�GDWD�ILOH�KHDOWK\

Fundraising Pro constantly adds data to your data file. But it also removes
temporary data and creates “holes”.  If your computer crashes in the middle
of operations, your data file may incur a corruption.  It is best to keep the
wholes to a minimum and we recommend you Compact your database
frequently (e.g. once a month, or every week on an intensively used
database).

To compact your data base:
q Quit Fundraising Pro.
q Back up your data file
q Start 4D Tools from the Start menu
q In the Open File dialog select the file: C:\frp\frpXXXs\frpXXX.4db file. Do

not press OK yet.
q Hold down the Alt-key and click OK.
q Select your data file.
q Chose compact from the Utilities menu.
q Select a sensible name for the new datafile.

This process will create a new data file, which you must open as described
in the previous section.

��� 7URXEOHVKRRWLQJ

����� 0\�GDWDEDVH�EHKDYHV�VWUDQJHO\��PHQXV�RU�GDWD�DUH�QRW
FRUUHFW

Index tables in your database can go out of sync due to crashes of
software.  As a result Fundraising Pro can behave very strangely: menu
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items do not perform their tasks normally or searches give the wrong
results.

If your data base is corrupted or if Fundraising Pro starts behaving in a
strange way, likely the problem can be fixed easily. Follow the following
steps to resolve your problems:

q Compact your data file as described in the previous section
q Open Fundraising Pro with the new compacted data file. In some cases

the problems will have disappeared, if not proceed.
q Quit Fundraising Pro.
q Open the compacted data base with 4D Tools as described in the

previous section
q Chose repair from the Utilities menu and select “Rebuild from tags”. This

process might take a significant amount of time and will create a new
data file.

q Open Fundraising Pro with the data file which was rebuild from tags. It
might take a long time for the program to open. In most cases the
problems will be gone.

q If the problems have not disappeared you must go back to a healthy
backup file.

����� $�:LQGRZ�LV�VWXFN�XQGHU�WKH�WRROEDU

If a Window, such as the clipboard or a data form has become stuck under
the toolbar, the following will allow you to move the window.

q Click in the window which is stuck with the left mouse button
q Press Alt
q Press the left arrow key
q Press the right arrow key
q Press the down arrow key – this will show you a menu
q Press the down arrow once more
q Hit return
q Hold down the down arrow key to move the window down
q Hit return or click when the window title bar is fully visible
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��� 8SJUDGLQJ�)XQGUDLVLQJ�3UR

< First duplicate the existing data file, and put it in your backup
databases folder.

1. Save password information:

q Open the existing version as administrator.

q Open the database and go to Edit Passwords.

q Open Save Groups, and save your user information to a disk.

q Under the Help menu, select About Fundraising Pro and note
what data file you are using.

q Close the existing database.
2. Install the new version

q Use the floppies, CD Rom or downloaded install file and double
click the setup program.  Install all options.  Note down the
version number shown by the installer.

q The installation has created a new directory, for example,
C:\frp\frp344. Your current version might be installed in a
directory like C:\frp\frp340, which has a lower version number.

q Copy (DON’T MOVE) your data file (which you noted down
above) into C:\frp\frp344.  Name the copy WWF344.4dd  if your
charity can be abbreviated as WWF.

3. Link data file to the new version:

q Single User Installation:

q Double click frp344.exe  in the C:\frp\frp344 folder (or use
the start menu)

q When the password dialog appears, select administrator,
and hold down the Alt  key while pressing OK.

q Select the WWF344.4dd data file. Opening may take
considerable time for large databases.

q Multi-user installation:
q Activate 4D Server
q In the file dialog select the structure file

C:\frp\frp344\frp344.4db hold down Alt while clicking
OK.

q Select the C:\frp\frp344.4dd data file
q Go to a client workstation, and log in as administrator ,

without password.
4. Load the password information

q Choose Edit Passwords  from the File menu and select Load
Groups.



7

Your new data base should be ready for use.
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�� 2YHUYLHZ�DQG�LQLWLDO�SODQQLQJ
Fundraising Pro is a very flexible and customizable set of linked tables in a
single database file. You will find that Fundraising Pro enables you to
navigate seamlessly from groups of people to their corresponding groups of
donations or transactions.
You need to decide what you want to store, where you want to store it, and
how you want to retrieve it. With careful preliminary planning you will be
able to organize your data in a way that provides lasting value, in the face of
an ever growing amount of contacts in your database. The section on
organizing your constituency data will give you a feel for what to consider.
In addition, there is system data to be set up.  Tax rates need to be defined,
popup lists and fields names should be entered, and for security you want
to assign passwords to your users. We cover such system setup in the
second section.  Importing data is another important issue that is at the
system level.

��� 2UJDQLVDWLRQ�RI�FRQVWLWXHQF\�GDWD
A flow diagram of what you can achieve with Fundraising Pro is drawn
below.

Other Databases

 Create records for
supporters

Create donation records

Enter instalments as they
are received

Produce R68 and reclaim tax
from Inland Revenue

Produce R185s for
signature; monitor return

of forms

Customise many of
the fields to suit your

organisation

Define events (can be
for groups or individuals)

 Build links

Produce income
projections, payment
schedules, graphs

Check for donation
inconsistencies

Track prospects

Produce highly-specific
lists of supporters or

events, and mailmerge

Direct data entry
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����� ,PSRUWDQW�WDEOHV
The people table stores contacts personal information This will include
name and address information but also a range of details such as career
milestones, memberships of societies, distinctions and other customisable
detail.  Related information such as events recording contacts with them,
and group events in which they participated can be recorded from the
people table in related tables, for convenience. Similarly can enter or
retrieve a supporter’s donations and their transactions through the people
database.
The donations table stores details of supporters’ intentions (promises, or
pledges) to give financial support. Actual receipts are stored in the
transactions database. Each promise is given a gift number, which is the
link between a supporter, a donation and an eventual transaction. The
separation between intention and receipt of payment enables you to record
covenants, and to keep track of the difference between installments already
received, and installments due in the future.
The transactions table stores the actual receipts - of money or gifts. Tax
claims, financial reports and projections are all based on data contained
here. Transactions are linked back to the donations data table via the gift
number.
The events table contains two kinds of event detail:
• Group events cover events like a summer ball, or sponsored swim, or

attendance at  meeting, or waterfall contacting where and event is linked
to multiple people. Whenever a supporter is linked to a particular group
event, the actual act of linking is stored in an event log table, so that
you can later look at an event and all the supporters who have been
linked to it.

• Individual events cover such events as a knighthood, or a telephone
contact, or a career move, or the birth of a daughter. All such events are
linked with a supporter’s record, so that you build up a profile not only of
his/her responses to your fundraising (group) attempts, but also an
ongoing record of his/her (individual) personal achievements and
progress. A supporter’s record can contain any number of individual
events. All events automatically have a date attached.

You can also group selections of people or donations together by Codes
and the Code Log  and Code log don tables, link these codes to donations
or people. Codes are independent of event codes.
You can isolate fundraising for specific events within the donations table
using earmarks.  Supporters may just send money, and your trustees
decide how it is to be spent. However, you can define earmarks, which are
funds within the appeal which supporters can target as their special interest.
For example, a supporter may earmark 60% of their donations for your
Library fund, 20% for your Sponsored Silence fund, and the rest for the pot.
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Or a donor could earmark 100% for the Chess tournament. Earmarks are
attached when you enter a donation’s details.
The tax information created in the database is vital to your accounting
department. All important tax transactions are stored in the Tax Records
table. Actions such as claiming tax, requesting a form, logging its return,
and so on, are stored there. You can revisit old tax claims and reproduce
old forms. You can also undo changes, if necessary.
A simple task table is implemented for project management. Tasks can be
freestanding reminders, or linked to people records, and can be allocated to
a particular user for action.

����� 5HODWLRQV�EHWZHHQ�WKH�WDEOHV
You can have records for people or organisations in the people table
regardless of whether they send money - a prospective donor, for example,
who has not actually sent anything yet; or a volunteer who doesn’t give
anything but time. Organizations or an employer may play only indirect
roles, such as providing matching gifts, but should also be entered in the
people table. When relationships exist among constituents, these can be
recorded and provide access from  employers to employees and vice versa.
Every donation needs to be linked to a supporter in the people table whom
we call the donor. However, the supporter record may be a record under the
name of Anonymous.
Similarly every transaction you receive and record in the transactions file
must point to a donation.  There can be many transactions per gift, for
example for covenants, just like a person can make more than a single
donation.
In the same spirit, an individual event must point to a contact in the people
table, and an earmark for a destination must have a corresponding gift in
the donation table.
Finally, tax records will points to donations.

All these relationships are called many to one relationships, indicating for
example that many gifts can belong to one donor.

A second type of relationship is more involved but also very important.  It
arises for example in the case of events. You plan your events
independently of attendance, for example you establish that on a certain
date you will hold a ball, and enter this in the events table.  As time goes
by, more and more people promise to attend the ball, and for each of these
and event log record is created, which links the event (the ball) to the
person in the people table. One speaks of a many to many relationship
here between the people and the events table: this expresses the fact that
there can be many events for a single person and many people attending a
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single event.  The event log is an intermediary table establishing the
relationship between a particular person and event.
Fundraising Pro uses such many to many relationships for events and
codes. To link codes to people there is the code log table and to link codes
to donations there is a code log don intermediary table.

Some tables are pretty independent of others. For example, the fields table
stands by itself, and so do the letters and reports (although they are related
to people on the fly during merges etc.).

����� &XVWRPL]LQJ�ILHOGV�LQ�WKH�SHRSOH�WDEOH
The people table is special in that it has a large number of fields which are
not allocated to specific data.  Phone numbers, addresses etc. are
allocated, but almost 100 fields are for you to allocate.
It is in these customizable fields that you can reflect the special features of
the constituency of your non-profit organisation.  During the development of
Fundraising Pro it became clear that having the flexibility was a key to
providing and adequate database more many types of organizations.
When allocating these fields pay careful attention to the following points.

I It is vital that you organise your data carefully. Please read the
following points:

q Data in the people table can be stored in many different ways, to suit
your needs. Storage of data in the other tables is less customisable and
maintained by the system.

q Some of the data fields are of a fixed size and will change in predictable
ways. For example: dates of joining/leaving, income estimates, or the
supporter’s old school House.

q Many supporter attributes can be defined by Yes/No answers (such as
questions of membership, privacy, and so on) and can therefore be
recorded by check-boxes rather than text.

q Some fields will contain data which will be used later to group similar
supporters for mail shots or other targeted fundraising. For example:
supporter types, address zones, membership of other societies,
professions. Others examples will be relevant to your own organisation.
Fields which are to be used frequently for sorting and searching may be

indexed (&29) for speed.

q In conjunctions with the personalized fields, to ensure that you enter
certain information in exactly the same way you should set up popup

lists (&22) wherever the information has a consistent format. This will
greatly help to search and sort such information. Existing Mentor users
will be familiar with the Lookup Codes used already throughout the
Mentor suite; Fundraising Pro’s popup lists fulfill exactly the same
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function. You can choose up to twelve data fields which would benefit
from standard popup lists, and create those lists to suit your own
organisation.

q Don’t use name and address fields but for storing names (of an
individual, company, or society) and addresses. If you add any other
information you will encounter problems when printing labels and letters
using macros.

q Use a single format (without words) for telephone numbers, suitable for
automatic dialing. Use an alphanumeric-type field, not numeric, if you
are storing telephone numbers in a customisable field.

q Customisable text-type fields can hold a large amount of information,
and are useful for storing descriptions and memos. However searches
on these fields can be extremely slow (again depending on your
hardware), and you may decide not to store information in these fields
which you may later need to search.

q Store accumulating personal information such as career moves, family
changes, and so on, as a series of personal event codes rather than as
uncontrolled text notes in random places on the supporter’s record. This
ensures a regulated buildup of data, which might later be useful for
sorting.

����� /RFDWLRQ�RI�LQIRUPDWLRQ
The majority of information stored in the database is entered through either
the People forms and its subforms, or the Donations forms and its
subforms. It is very likely that you will be defining and generating your own
reports, to customise the way in which you want to extract and display
information from the database. You are able to use Fundraising Pro’s Quick
Report option to produce such reports, as well as 4D Write for full page
reports.
To define your own reports, you will need to know the fieldname and
tablename used within the Fundraising software. All the field names and
locations are listed on page at the end of this chapter.
Bear in mind that when you have renamed some of the customisable fields
you will need to use each field’s original system name in report layouts,
sorts and searches. This will change in a later release.

��� 6\VWHP�VHWXS
To get your system off the ground, think thoroughly about its use and future.
Then complete the following setup routines:
� User and Group Security
� System Parameters (tax rates, address of your organisation etc.)

� Customised Fields&31
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� Popup Codes&22

� Relationships&Error! Bookmark not defined.

����� 8VHU�DQG�JURXS�VHFXULW\
 (File menu)

G Security setup can only be carried out within the Administrator
privilege level. The users, groups and passwords defined here are

used in the login screen - &44 - and determine the level of
access available to each user.

Define groups
Default groups are already established on the software. You should not
create new groups.
Add a new user
q Select the Edit Passwords menu from the File menu, then choose the

New User  item from Passwords.

q Enter the new user’s details

q Leave the start-up procedure field blank.

q Save the screen.
 

Add the user to a group
q To add this user to a group, point the mouse at the appropriate user

name, hold down the left button, and drag the user name to the group
where this user is to be a member. Then let go.

Assign passwords to users

q Select Edit Passwords from the File menu,

q Select (double-click) the user,

q Key in their password and click the Close button on the window.

<
Backup your password and user data by selecting Save
Groups from the Edit Passwords \ Passwords menu. Store
the data in a file called c:\frp\pwd.4ug. You will be able to save
time later by importing this data into a future version of
Fundraising Pro.

Setting passwords is a vital protection of your data, particularly on a
networked computer.  Change your passwords frequently, and make
sure they are not easy to guess.
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I
If you do not set passwords, or if you have copies of
Fundraising Pro software on your system in which passwords
were not set, then the program allows administrator access to
any user without asking for a password. This means that your
data may be at risk. Always install passwords, right away, and
do not keep unprotected FRP copies around.

����� 6\VWHP�6HWWLQJV
 (File Menu or Data menu)

These parameters can only be edited when you are logged on ad
administrator. To access the working screens from the File menu, open
the Open Database menu and double-click the single row of system data.
Double clicking allows you to amend data.
To access the same screens from the Data menu, select System File.
This action opens a screen containing two tabcards:
Settings tabcard

G The name of the charity cannot be changed without invalidating
your licence key. Contact Stelias or your reseller if you wish to
change the name of your charity.

q Enter or change your charity’s address,

q Now enter a list of tax rates into the database. Enter a tax rate for any
period in which transactions are promised, or due. The system uses the
current tax rate as the basis for future projections, so give an extended
last date of validity which will encompass your projections for the final
tax rate, the one currently in effect. Make sure all dates are entered
correctly and that the periods are adjacent.

 

Date-stamps triggered by your actions
The change of an address, and the contact date, are stamped
automatically in their own date fields, i.e. changing an address changes the
address last changed date, and similarly for contact date.  But you can set
up to two further date-stamp triggers. For example, you might create a
custom box which is ticked the first time a supporter gives money - this
could be date-stamped using one of these triggers. Date-stamps can be
assigned to any field within the people file, so you will probably have to
leave these trigger checkboxes blank until you have defined your
customised fields.

q When you are ready, click the checkbox on and select the field which is
to trigger the date.

Popup Lists tabcard
During your fundraising campaigns you will want to select records based on
various criteria - all supporters who live in Gloucestershire, for example, or
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all architects, or which payments were made by cheque and which by direct
debit.
To ensure that all search targets do indeed appear in your selections you
must ensure that data entry is consistent throughout the system. Do this by
setting up lists which are used whenever the contents of a particular field is
used for searches, and when it contains information in a consistent format.
These popup lists can contain complete words, or abbreviations, or
acronyms - whichever suit your needs.
This screen is where you define a popup list and assign it to a field. You can
attach up to twelve popup lists to the people file. Each popup list can
contain thousands of items, but you should restrict the list to a manageable
size.
It is very likely that you will want to create popup lists for the following fields:
type (of
supporter)

for example: Individual or Company - additional but
less permanent definitions such as trustee, or
sponsor, or OMA member, or prospect, can be
recorded in customisable checkbox fields

sex M, F or blank is best
degrees
or
distinctions

If your institution awards degrees or distinctions, and
you want to enter these in custom fields,  standard
popup sets would be sensible

occupation you could copy the Mentor Core Database Occupation
lookup codes here, for continuity

Depending on the geographical scale of your membership, you may also
find it useful to define popup lists for nationality, counties, countries, and
a code of local can be useful if you want to invite supporters to in-school
events. Mailzones has a pre-defined list prescribed by the Royal Mail.
Other fields can have popups to suit your use of the system.

G Wait until you have settled on your customised fields (&31)
before completing all your popup lists.

Popup lists can easily be moved from one field to another.
The popup tabcard screen is divided into four areas, and displays details of
any popups which have been defined so far:
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Linking a new popup list to a people-related field
q Check which lists (coded 1 to 12) are already in use by scrolling through

the field to list links in the people popups area.

q Click the field-to-list-links  button to open a window in which you
specify the list number and the associated field name where the list
should appear.

q Save this data.

q Click on the popup-list-contents’  button, which opens a window,
where you...

q Select from the displayed numbers the number of the list which you now
want to use;

q Key in the individual elements which are going to form the list (for
example: Glos, Avon, W Yorks, for a counties popup list).

q Specify the position in the list for each element (see the warning
below)

q Save each element as you enter it.

G When you build your popup list you must assign a position to
each item, to determine the order in which the items appear
when they pop up. You can put the most common code at the
top of the list, making it quick and easy to invoke.

However, once you have defined a list you cannot maintain an

use these buttons to remove or
enquire about a highlighted
contents list item, or add a new

use these buttons to remove or
enquire about a highlighted people
pop p or add a new one

the number in each
field refers to an
existing popup list
number. Double-click in

you will only need to create account
popups when a later release of FRP
enables links to your accounts
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alphabetical order by inserting another item. If this might be a
problem, you should leave two or three blank rows between
your position numbers, when creating this particular popup, so
that you can go back later and insert another one. Start by
positioning items in positions 10, 20, 30, 40 and so on, and fill
in the intermediate positions later. Blank positions are not
displayed so the popup list looks complete. You will be able to
print out and import popup lists in a later release.

4
To find out what is in a pop-up list, scroll through the popup list
contents window and find entries against the relevant list
number. Note that list items are not necessarily grouped in
order, or together.

Popups for earmarks, payment types, appeals and event types:
In addition to the people-related popups, you may want to define the
following system lists:
earmarks

G

codes used to identify different funds or spending
areas within an appeal - the Tennis Court repair fund,
for example, or an ongoing Library fund. Earmarks
can be directly attached to group events, or can be
independent of them.

armarks must be assigned to each donation to which it
applies; you cannot globally indicate that every
donation from this particular supporter always goes to
this earmark.

Payment types codes which identify the different ways in which
supporters send in their money - you will need to
include a payment type for non-monetary gifts

appeals leave this popup set blank until a later release
event types define the type of event which you will be setting up.

For example: dinner, phone call, party, conference.
Define your own codes to suit your own needs

To define popups for these four factors:
q Find a spare number in the list of 12 (as described above)

q Key that number into the empty field next to the name of the factor

q Click the  button in the popup-list-contents area

q Build the popup list as described above.

G The popups which you create for earmarks, payment types,
appeals and event types do not become available until you have
closed and reopened the database. Other people-file popups are
available immediately.
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����� 'HILQLQJ�&XVWRP�)LHOG�1DPHV
 (Data menu)

Having decided on the information you want to store about your supporters,
and about the events which you run or anticipate running, you now need to
see which of this information can be stored in the pre-defined data fields.
The remaining information will almost certainly fit into one of the many

customisable fields (&31) which are scattered throughout the people data
entry screens.

Re-read the section on organising your database (&Error! Bookmark
not defined.) before you start defining fields.

����� &XVWRPLVLQJ�)LHOG�1DPHV
There are two types of Field Names in this database. Some standard
fields, such as surname, address, and so on, already have field names
assigned to them. Other fields just have system names, at this stage, and
they are there for you to use as you wish (like the Ref fields in the Mentor
Core Database).
Standard Named Fields
The fields already named when you first start using FRP are listed in the
Reports section of this Procedure Guide - & Error! Bookmark not
defined.. You cannot change these names, and should not deviate from
their standard purpose, since the functionality of the field will not change.
For example, the postcode field is used in address formatting, and should
not be used to store a region code.
Customisable fields
However, a large number of non-standard fields are designed to have their
system-names changed to suit your own requirements. The system names
give no clue as to the field’s use, so when you decide to use a customisable
field you should rename it so that other users know what to enter in that
field.
The customisable fields, and their various locations, are shown in the table
which starts on page 31.
Be aware of the location of the fields on the forms, since this obviously
constrains their function to a certain extent. For example, alpha11 appears
in the Quick Entry screen and the Alternative Address screen, and is an
obvious candidate if you need to record a supporter’s mobile phone
number, since ‘mobile’ is not a named telephone-type field. Alpha11 allows
20 characters (alpha and number), which should be enough for a mobile
phone number.
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Once you have decided, at least for now, which fields need to be brought
into use for your database, you will use the Fields option on the Data menu
to make your changes:
Change a fieldname, and flag it for indexing:
q Find the system name for the field you want to customise,
q Key in your new name,
q Specify whether or not you want the field to be indexed.

G
If you want later to be able to search on this field, it may be
indexed if experiments show that indexing dramatically increases
the search speed - this depends very much on your hardware.
However, index files occupy space and you should consult Stelias
or your reseller if you have any doubts. You will probably want to
index several of the important customizable fields in your
database, if you have created these fields.

G
Indexes occupy space on your hard disk. The increased size of an
index datafile may also slow down backups, and perhaps repetitive
data entry. If speed becomes a problem during searches, check
through the Fields option and remove Index flags from those fields
which are not used during any of your search routines.

* Date1 and Date2 are already linked to the trigger facility which can

be set up in the system setting screen - &Error! Bookmark not
defined. - so they should be reserved for this activity.

Once the fieldnames are settled, you can create your own sets of popup
codes to standardise the data entered in fields where accuracy is crucial -

&22.

You may find the worksheet in the appendix a handy way of deciding on
your custom fields.

��� $SSHQGL[��FXVWRP�ILHOGV�ZRUNVKHHW�
The following lists show the field names and table locations which you can
safely use to create your own reports by extracting information from the
database. The list is in alphabetical order of Table name.
Using these tables to identify standard field names, and devise
popups:

G
The field size given in the following tables is the maximum.  When
deciding the style of any popup codes which you may be defining,
you can create shorter codes if you prefer. All codes can contain
letters, or numbers, or a combination, but they should not contain
any gaps or punctuation marks.
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Screen location(s):
n AA = Alternative Address
n FD = Full Details
n OV = Overview
n QE = Quick Entry
n DC = Donor and Custom Output layout on Database opening screen
n SL = Standard List layout on Database opening screen
n PI = As column-heading on Payments Info layout of Donations opening

screen

Field types and sizes:
n alphanum =any mixture of alphabet or number characters (no spaces)
n integer = whole number up to 9999999999
n test = checkbox
n float = currency £0,000,000.00
n text = free form text, or note

Use the right-hand column to pencil in your ideas for customisation
Orig
Field

Type& length F
D

O
V

Q
E

A
A

D
C

S
L

PI Custom
name
(with
example)

alpha
1

alphanum 12 Honours

alpha
2

alphanum 12 school
House

alpha
3

alphanum 12 marital
status

alpha
4

alphanum 12

alpha
5

alphanum 12

alpha
6

alphanum 12

alpha
7

alphanum 20 Mentor
Pupil Code

alpha
8

alphanum 20 (Girls/Boy
s/Junior)

alpha
9

alphanum 20

alpha
10

alphanum 20 mobile/pag
er

alpha
11

alphanum 20 mobile/pag
er

alpha
12

alphanum 20

alpha
13

alphanum 40
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Orig
Field

Type& length F
D

O
V

Q
E

A
A

D
C

S
L

PI Custom
name
(with
example)

alpha
14

alphanum 40

alpha
15

alphanum 80

anon checkbox anonymous
donation

date1 TRIGGER
date*

datestamp
an action
-

date2 TRIGGER
date*

see System
setup
screen

date3 date School
entry date

date4 date School
leaving
date

date5 date
date6 date
date7 date Renewal

date
float1 £0.00

currency
Salary

float2 £0.00
currency

float3 £0.00
currency

int1 whole
numbers

int2 whole
numbers

int3 whole
numbers

int4 whole
numbers

int5 whole
numbers

int6 whole
numbers

int7 whole
numbers

int8 whole
numbers

test1 checkbox
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Orig
Field

Type& length F
D

O
V

Q
E

A
A

D
C

S
L

PI Custom
name
(with
example)

test2 checkbox Old
Members’
Assoc

test3 checkbox Newsletter

test4 checkbox Magazine

test5 checkbox
test6 checkbox
test7 checkbox
test8 checkbox
test9 checkbox
test10 checkbox
test11 checkbox
test12 checkbox
test13 checkbox
test14 checkbox Don’t mail

test15 checkbox Pass
Details

text1 scrollable
notes

Family
data from
Core

text2 scrollable
notes

General
Interests

text3 scrollable
notes

text4 scrollable
notes

Previous
school

text5 scrollable
notes

Subsequent
school/uni
v

text6 scrollable
notes

text7 scrollable
notes

text8 scrollable
notes

text9 scrollable
notes

text10 scrollable
notes

text11 scrollable
notes
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��� 7DEOHV�RI�ILHOGV
This section contains a large number of tables which describe the field
structure of the database.  Use this for reference.

����� 'RQDWLRQ�ILHOGV
Field name Description
latest_tax_date date on which tax was last claimed for this gift
allocated what  percentage of donation is allocated to an

earmark
appeal to which charity or appeal does this donation

belong. Taxes will be per appeal.
Type Is this a gift aid, covenant, company covenant etc.
method_paym How are you receiving money?
first_pay_date when is the first payment of this gift expected.
end_date number of years of the gift (duration)  after the first

payment date
frequency how often is a payment expected
total_amount total pre-tax amount of gift
accumul_amount how much has been accumulated (this is updated

by the update accumulated menu or by double
clicking a gift)

installment how much is expected per payment
annual_amount how much comes in per year
tax_form_mailed has an R185 or R190 been mailed to donor
tax_form_receiv has the R185 or R190 been returned to your office
company_uptodat not used
num_latest_clai how many payments were included in the latest

claim of tax
type_of_anomaly what is wrong with thid donation?
anomalous is something wrong with this gift? (yes/no)
value what is the value. Could be foreign currency,

equipment, land, need not be monetary
final_pay_date when is the final payment due on this gift.
comments yours to supply
wishes_reminder to be used to notify donor that payments are due

shortly
record_number This links the donation to a record in the people file

to indicate who is the donor.
Duration_yrs For how many years will this donation last
gift_date When was the donation made
conseq_no How many tax claims have been made so far
cov_form_rec Has the covenant form been received. Normally not

needed but if donors do not supply it, here is the
place to keep track.

entry_date When was it entered into the db. Set automatically.
credit card no which card was used.
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credit card typ what type of card
mail_taxform used internally by the tax routines.
dt_ltst_cl_pmt date of the latest claimed payment. Which was the

last payment on which we reclaimed the tax.
active Is the donation still active for tax purposes
tax_form_needed used internally
expiry expiration date of credit card used to make gift
amt_latest_clai how much was claimed in the latest tax claim.
first_claim Is the first claim on the gift imminent?
gift_number Unique number for every gift to link to transactions,

tax records and code log don
gross value value of gift after tax.
group_gift was this made on behalf of a group?
account_no bank account from which money will be deposited.
account_name name of account holder
sort_code sort code of bank from which moneys are to be

received
bank_name name of bank
bank_address address of bank
truptodate this indicates if the expected payment dates on the

transaction record will be accurate. If not these will
be automatically re-computed during tax runs.

inc acct name of account into which payments should go
tax acct name of account into which tax reclaimed should

go
inc ledger ledger for payments received
tax ledger ledger for tax received.

����� 3HRSOH�ILOH��FXVWRPL]DEOH�ILHOGV�LQ�SUHYLRXV�DSSHQGL[�

Field name Usage
record_number unique number for every record
surname
postname
initials
salutation used as header for letters
forenames
pref_forename preferred forename
birth_date
sex
type describes the type contact is this: company, parent

pupil etc.
creation_date this date is set at the date of entry into the database
nationality
comments
occup_code occupation code
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add1
add2
add3
town
county
country
postal_code enter UK postal code with a single space in the

middle to ensure mail-sort with Mail-code Pro works
correctly

phone_1
phone_2
fax
email
alt_add1
alt_add2
alt_add3
alt_town
alt_county
alt_country
alt_postal_code
alt_phone_1
alt_phone_2
alt_fax
alt_email
referred_by you could mention the name of the referral here
last_contact_da when was last contact made with this constituent
last_add_update when was address last updated. This field is set

automatically.
is_donor is this contact a donor. Set automatically.
donation_tot total of donations made by this contact.
anonymous does this contact wish to be treated anonymously
title
prev_surname
mail_zone use the precise Royal Mail mailzone here, as

indicated in the popup list.
area_desc you can enter your own area descriptor here, eg.

north, south, foreign
alt_mail_zone mail zone for alternate address.
alt_area_desc
sortcode this is a composition of surname, prefixes and

initials, exactly like in the BT phone book. This is the
default sort order for people views.
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����� &RGHV���&RGH�/RJ���&RGH�/RJ�'RQ�DQG�(YHQWV���(YHQW�/RJ
WDEOHV
These small tables are all of a relatively simple type and are collected in the
following table

Table Field Description
codes code short mnenonic for the code

description text field description for a code
summary 30 character summary

code log code links a codes entry to this code log entry
record_num
ber

links a people entry to this code log entry

code log
don

code link of the codes records for this donation
code log

gift_number link to this gift number.
events event_code short mnemonic

summary summary 30 chars for event
type type of event as specified by pop-up lists
creation
date

when was this event created?

content long description of event
who who entered it?
Individual is this an event that applies to a single

individual or to a group
event log event_code links an events record to this logging entry

record_num
ber

links a people record to this logging entry

date when was this particular instance logged
order in what order should is show in included lists
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�� :RUNLQJ�ZLWK�)XQGUDLVLQJ�3UR
For the most part, Fundraising Pro is a standard Windows and Macintosh
program. However, some features are specific to Fundraising Pro, and you
should make a mental note of the following sections.

��� /RJJLQJ�RQ
When you launch FRP, you see the login screen. This is where you select
the appropriate level of access for what you want to do:

Designer This is the highest level of access, reserved for the
programmer, and may not be visible at all.

Administrator The administrator has access to all of the menu
options, including setup features, preferred layouts,
field indexing, passwords. This level will only
normally be available to your System Manager and
Dolphin staff.

Office Head The Office Head has access to the full range of
information on the people database, and can edit
transactions.

Finance User The Finance user has access to the special
financial functions, such as running the Taxes
options, as well as complete access to the people
and donations databases.

Accounts User This user can enter and edit transactions, but not
the donation details or tax data.

Other User This level of access allows the user to look at basic
details on people and events, but not to change or
enter any details.

q Highlight the appropriate User Type with a single click,

q Key in your password,

q Click OK if you now want to use the data set which you were using
before,

q OR

q Click Alt+OK if you want to select a different data file (the file dialog box
will list your files; double-click the one you want to work on).

G
Once you are past the login screen, you are committed to using only the
default database. If you need to change to another database you must
repeat the login routine.
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����� $GPLQLVWUDWRUV
Administrators are the only users with permission to:
1. Delete large groups of records,
2. Import records
3. Edit the system or fields tables
4. Apply formulas.
5. Swap fields
6. Do anything other users can do

A difference between the Administrator is that they should use the File
menu, and select Open Database to get to a control panel.

����� )LQDQFH�8VHUV
Fundraising Pro Control Panel screen
q The Finance menu is active when the control panel shows and can be

used for Taxation operations. Other users (apart from administrator)
do not have permission to run finances.

q Click the Open Database button to display the full Donations list.

����� 2IILFH�+HDG
As Finance User,  but gets the full People list instead of Donations. This is
the common log in level.

����� $FFRXQWV�8VHU
Takes you straight to the Transactions file. This is useful for accounts staff
who do not wish to be exposed to the full menus

����� ,QTXLULHV�RQO\
You may want to allow other members of staff to look at the data stored
within Fundraising Pro, but not be able to edit or change it in any way.
You can offer this facility by ensuring that such members of staff log on as
other user in the opening screen. Passwords should protect the higher
levels of access. You will have to set up other user with a password which
can be circulated to appropriate staff.
Takes you straight to the People database, for inquiries only. No access is
given to donation information.

��� 0RYLQJ�IURP�VFUHHQ�WR�VFUHHQ�DQG�HQWHULQJ�GDWD
The working screens in Fundraising Pro are very dynamic. From your
opening lists (of people or donations) you can quickly open a screen full of
details simply by double-clicking one of the items on the list.
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You can also hop between people and donations very quickly by
highlighting (for example) a few supporters on the people list then clicking
the donations button on the toolbar. You will immediately be presented with
the donations details for just those selected supporters. This is automatic
relational search. Again, you will double-click one of the donations to open
the details screen.
Click the Cancel button, or key Esc, to close the form canceling the
changes. You will always come back to the original lists by hitting Escape a
few times, so you can use this to climb in and out of the different data
tables. It is easier to do than describe!

G When moving from one table to another, using the data menu or
the toolbar buttons, the selections which you will see on screen
depend on what was highlighted when you set off. So if you had
highlighted just one supporter in the people list before clicking the
donations button, only that supporter’s details would be displayed.

You can list all records by clicking the  button.

Mouse action 8
Double-clicking the left mouse button opens the detail form when in a list -
for example: double-click a name in the database list to open that
supporter’s record card.
Single-click to highlight a record in a list.
Shift+click and Control+click work in the normal Windows way when you
want to highlight a consecutive group of records, or highlight a number of
non-consecutive records.

Keyboard options 7
The Ctrl-a hotkeys, and Alt-a menu option launchers followed by keying
underlined letters, work in the standard Windows way.
The keyboard equivalents of other commonly-needed FRP actions are:
Abandon a screen Esc
Save a modified record or accept a dialog: Enter (the number-pad Enter

key, not the main keyboard Return key)

Working screen size

The active screen does not occupy the whole of your monitor’s available
window.

I
Do not resize the screens. You may see some buttons and the
screen does not refresh properly. This restriction may be fixed
in a later release of 4D.

Multiple screens
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Fundraising Pro automatically closes the current screen when you open a
new option, so you do not have to Close a screen before opening another
one. Only one screen is ever open at any one time, with the exception of
some sub-screens, which may be superimposed on the main screen.
Add new records or pop-ups

Click the Plus-sign button if you want to add a new record to any table in the
database, i.e. add a contact or add a donation, or add a pop-up, and so on.
You have to click it before you add a new record. When pressed you will be
presented with an empty form to enter details.
Quit a screen

Esc or 

To abandon a screen without making any changes, use the Esc key to back
out, or the Cancel button on the Toolbar.

Enter numbers

You must use the number keys along the top of the main keyboard; the
number pad which is normally invoked by the NumLock key is not
accessible in this release.

Entering dates

FRP will accept and process accurately post-2000 dates. When entering a
date, you should normally just need to enter the actual date as a continuous
string - 300497 - rather than entering 30/04/97.

Enter text

You can use all the normal Windows features when entering text into a data
field - copy, cut, paste all work, if you need them.

G
But the system does not support your keying Page Down to
move the cursor to the end of the record.

G Be careful of hidden spaces. If you have accidentally keyed or
imported a space at the end of a name then that space becomes
part of the saved name. If you know that you have a supporter
called Dolphin but cannot find it using a surname search, try
putting the wildcard in your search criterion and ask for
Dolphin@. If the record is found, it means that you have saved
the surname plus a space.

Further information about entering and modifying data is available in the
associated User Guide.

Move within a data field
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Use the Home key to move to the start of the field, and End to move to the
end.

Move down the screen

Use the Tab key to move down the screen, from one field to the next.
Use Shitf - Tab to move back up the screen, from one field to the previous.
If the system fills a field for you, you can Tab to next field, accepting it, or
replace the contents by typing your own text.
Validation

You will be warned if you have keyed in a text string or number which is not
acceptable to the system, or if you have failed to complete a mandatory
field. But you should consider using pop-up codes in crucial data fields.

G In the current version it is important that you take warnings
seriously and correct the information as suggested in the warning
messages. If you dismiss the warning your data may be saved in
the wrong format.

Use pop-up lists

If, during completion of a record, a pop-up code set has been linked to the
active field - &22 - the system automatically displays that code set when
you move the cursor to that field. You will normally click one pop-up code to
insert it in the field.
Move through the popup list either by keying Down-arrow or Up-arrow or
by keying the first letter of the word you want to use.
You can use the Esc key to close the popup box without selecting any code
and then key in non-standard text. But this would defeat the purpose of
standard codes, and should only be done in well-understood
circumstances.
Save data

The Save button lives along the top of the screen, with the other Toolbar
buttons. If the system seems to be ignoring you, it is probably waiting for
you to click the Save button.
If you are working without the Toolbar, you can instead use the Enter key to
save data. This key is normally in the far right-hand corner of the keyboard,
next to the number pad, and need only be used when you have finished a
screenful of edits or additions.
Delete records and codes

You will see the Delete button icon on various screens.

I
Double-click a single record and key the Delete button to delete
the record. The administrator can delete the list of highlighted
records in any table. Do not do this without very good reason. If
you drag a record, or a code, or an event, to the dustbin it is
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gone for good! You will be warned if an about-to-be-deleted
supporter’s record contains outstanding financial obligations.

Edit buttons

 This three-button group appears on many FRP screens. They can be
invoked once you have highlighted a screen element (see page 24 for an
illustration of such a screen).
The dustbin will delete whatever is highlighted.
The i will pop up a window which shows all the available information about
the highlighted element, and allow you to edit the detail.
The + allows you to Add a new element of the highlighted kind.
Navigation arrows

In any full form screen, if these arrow buttons are available you can use
them to scroll through your (people, donation, and so on) records. The
buttons will move you, respectively, to the very first record, to the previous
record, to the next record, or to the last record.

��� :RUNLQJ�ZLWK�LQSXW�IRUP
This section explains some of the more complex, or crucial screens, and
fields whose purpose may not be immediately obvious. They appear in the
order in which you would normally use the software during the course of the
financial year.

Quick Entry screen access by double clicking

people records

This is where you record non-financial details about each supporter.
Most of this screen is self-explanatory. Use the Tab key to move down the

screen (&51). Specific fields are explained below:

q If a popup list appears when you move to a field, double-click what you

want (&51).

q The record no field automatically displays the next available number,
generated by the system.

q The type field is designed to store the type of supporter. You may have
defined a popup list if your supporter types are varied.

q When entering UK post codes, you must put a single space between
the Outgoing Postcode (the first half) and the Incoming Postcode (the
second half) if you want to use Mailsort.

q The last contacted field is filled automatically by the system when you
have assigned an individual event code. You can use the last contact

date as a parameter in the Quick Search option (&113).
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q The last address field date could be filled automatically by the system if

you specify this as one of the trigger dates (&21).

q From this screen, you can access the Alternative Address subscreen

(&54), the Add Donation subscreen (&55), the Add Event

subscreen (&57) or the Further Fields subscreen (&58).

q You can also click on the current screen type field (top right-hand

corner) to access the Overview (&58), Events-Codes (&59),

Correspondence (&59), or Mailmerge (&105) subscreens.

Alternative Address screen
This is where you can record an alternative address for a supporter. Much

of the detail is the same as in the Quick Entry screen (&53) and should
be completed in the same way.

Use the � key to move down the screen (&51). Specific fields are
explained below:

q If a popup list appears when you move to a field, double-click what you

want (&51).

Add Donation screen access via Data menu

or Donations button

or People button

This is where you enter the intent to donate, and record bank and future
payment details. The actual contents of the screen will depend on which
input layout is selected in the opening Donations list screen.
The Donations toolbar button offers the input layout of master, which
contains three tabcards:
input layout appearance
Entry gift number and donation details, plus fields for entering

earmarks, comments, ledger accounts, codes. Tags a
donation with a code and credit card details

Trans enables you to enter the actual receipt of the donation as
well as edit such detail information

Tax contains a window which displays tax details

input layout appearance
Entry details entered in the Donation screen are repeated
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here, plus fields for entering credit card details
Entry
(buttons)

this small screen contains the scroll (&53) and edit

(&52) buttons, for fast entry of a batch of receipts
Fully editable similar to Entry (buttons), with the addition of ledger

account codes, and expanded tax data for instalment
entry.

Entry tabcard:

Most of this screen is self-explanatory. Use the � key to move down the

screen (&51). Specific fields are explained below:
q If a popup list appears when you move to a field, single-click what you

want (&51).
q The gift number is automatically generated by the system. Note that

this number identifies a promise to pay or give - the actual receipt is
entered in the Transactions option, as a bank transaction.

q The date of gift field will give you an error message if you enter a
payment date greater than the 28th and instalment payments are to be
direct-debited.

q The tax form checkboxes will be empty if the gift enables a tax claim, so
that you can complete them later. Otherwise the checkboxes are ticked,
which can be ignored.

q The bank account referred to in this screen is the supporter’s.

q Save (&52) the details when you have finished.

Add Event screen People List & Full
Screen forms

This is where you add an event to a supporter’s record. You can also
create, edit or delete individual event codes here.

Most of this screen is self-explanatory. Use the � key to move down the

screen (&51). Specific fields are explained below:

q Create a new individual event code:

q Click on the  button to add the details which will make up a new
event code;

q Enter the new code (check that new codes meet any existing design
standards which are applied by your organization).
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q Use the description field to give a fuller explanation of the event. Your
text can scroll beyond the visible window. This description is only ever
used in this screen, but can be printed in reports. Use the summary field
(max 25 characters) to record a brief description.

q Click on the  button to display the complete details of an existing
code if you need to check it out.

q Click on the Delete button to remove events highlighted in the list.

Further Fields screen
This is where you record fuller details about your supporters and examine
all personal data.
Most of this screen is self-explanatory. Use the Tab key to move down the

screen (&51). Specific fields are explained below:

q If a popup list appears when you move to a field, double-click what you

want (&51).

Overview screen People table

This is where you view general event and donation information.
Most of this screen is self-explanatory. Use the Tab key to move down the

screen (&51).

Events-Codes screen People Table

This is where you view the codes and details of events which have been
assigned to a particular supporter.

Most of this screen is self-explanatory. Use the � key to move down the

screen (&51). Specific fields are explained below:

q If a popup list appears when you move to a field, double-click what you

want (&51).

Correspondence screen Access via the people
file in a full form view

This option is only of use when you have 4D Write. It allows you to
instantaneously write a mail merge letter to an individual or group.
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��� 0HQXV�DQG�WKH�WRROEDU

This menu is displayed when you log in to Fundraising Pro:

Here is a diagram which shows the menus sub-menus. All of the options
are described in the appropriate Quick Reference Checklist or the Other
Options section of this Procedure Guide, and all options appear in the
Index. If a menu option is not available to you, it will be grayed out. Some of

the menu options are also accessible through a Toolbar (&65).

FileÀ Open Database
Close Database
Change Access
Edit Passwords
Printer Setup
New Data Window (not all
versions)
Import Data
Export Data
Quit

EditÀ Undo
Cut
Copy
Paste
Clear
Select All
Show Clipboard

DataÀ People
Donations
Tasks
Letters
Transactions
Tax Records
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Codes
Events
Earmarks
Code Log
Code Log Don
Relations
Event Log
System File
Fields
Relationships

RecordÀ Add Record
Find Or Add
Enter Related
Delete Selection
Graph
Quick Report
Print Layout
Labels
Mailmerge
Apply Formula
Search By Formula

SelectionÀ Code Search
Assign Code
Remove Code
Memorise Selection
Add to Memorised
Omit from Memorised
Swap Current and
Memorised
Show All
Show Selection
Event Search
Add Event
Remove Event

SearchÀ Search All
Search Selection
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Repeated Search
Quick Search
Repeated Quick Search
Find Donation By Name
Search Related
Search Editor
Sort
Mailsort

FinanceÀ Entry By Code
Entry By Name
Print Journal
Check Pledges
Check Covenants
Check Gift Aids
Check Selected Covenants
Process R185
Gift Aid Tax
Covenant Tax
Update Pledges
Graph Income
Print Actual Income
Export Transactions

SpecialÀ Toolbar
Save Default View
Swap Addresses
phONEday
Update Donation Info
Update Accumulated Amount
User Mode
Design Interface
License

HelpÀ Contents
Search for Help On...
How to Use Help...
About Fundraising Pro

The menus are described in detail in a later chapter.
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The Toolbar buttons have the following functions. You can toggle this
toolbar on and off using the Toolbar option on the Special menu.

Open the people file

Open the donations file

Add (this button is context-sensitive, so it will mean Add a Record
in the People database, add an Event code in the Event option,
and so on)

Display the whole list of database records

Enable a quick search for a record on screen

Specify a sort order for the records on screen

Delete: in a full page screen, delete the record on the screen.  In
an included list, delete the highlighted record.

Print a special report

Move to the first record in the visible selection (whatever table
you are working in)

Move back one record

Move forward one record

Move to the last record in the visible selection

Cancel close the screen and don not save the changes just
made.

Save the current details to the system
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�� (QWHULQJ�DQG�JURXSLQJ�GDWD
Clearly entering data and grouping it for appropriate purposes is one of your
main tasks.  We cover the details in this section.

��� $GGLQJ�D�QHZ�FRQWDFW
To display the list of supporter records in your database, you should

q Click the  button on the Toolbar
q OR
q Select the People option from the Data menu.
 

G The screen you are offered next will depend on the default
displayed in the main people database screen.

The blue Output field tells you the form in which you are currently
listing at the data. You can change it by clicking on the field.

The blue Input field tells you what layout you will open next. The

options will be Quick Entry (&53), Further Address (&54),

Details (&58), Overview (&58), Events-Codes (&59),

Correspondence (&59), and Mailmerge (&105). You will
normally use the Quick Entry screen, unless you regularly need to
enter more than one address for your supporters, in which case
you should use the Further Address screen.

q Click on the Plus button in the Toolbar, or select Add Record from the
Record menu.

q Complete as many fields in this first screen, drop to Further Fields
(&58) to complete your customised fields,

q If appropriate, set up a Relationship  with another supporter.
q Save (&52 )the details when you have completed your entries.

��� 6HWWLQJ�XS�*URXS�(YHQWV�DQG�WKHLU�FRGHV

Your fundraising activities may include events such as a Summer Ball, or
Founders’ Dinner, or an Emergency Roof Repair drive. They may also
include more events such as a Sponsored Swim for a selected group of
contacts, or an old-rugby-players Dinner.
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You can keep track of how active your supporters are in supporting your
efforts by setting up Group Event codes. Once set up, you can then add the
event to the supporter’s record.

q From the Data menu, select the Events option.

q From the Record menu, select Add Record

q Enter a code for the event (maximum of 12 characters), content, and
summary (maximally  25);

q Select the type from the pop-up list (see &22);

q Tab past the system-generated creation date, or overwrite it;

q Enter your FRP user name in the who field if this is appropriate

q Save (&52) the details.

G
Annual events, such as a summer ball or a Halloween party
should be set up as separate events, with separate codes,
because each event setup includes a date.

4
Use the Event Search option on the Selection menu to display
existing event codes on screen.

��� $GGLQJ�(YHQWV

����� $GGLQJ�3HUVRQDO�(YHQWV�WR�D�VXSSRUWHU¶V�UHFRUG�
q Select the person to whom the event will apply;

q Open their Quick Entry screen and click the Add Event button (or their
Overview screen, or their Events-Codes screen);

q Specify that this is an individual event;

q Select the event type from the popup list (&22);

q Enter a note to expand the description of the event (for example, if the
event type is phone call then you could note brief details about the
contents of the call) - these notes can be printed out using Quick Report

Writer (&104).

q Save (&52) these details.

����� $GG�D�JURXS�RI�VXSSRUWHUV�WR�D�*URXS�(YHQW�
q Select(&Error! Bookmark not defined.) the group of people to be

included;

q From the Selection menu, open the Add Event option;
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q Select the event code;

q Click the Assign button.

4 Use the Event Log option to see when the event log was
created, and which records have been assigned to each event.

Individual Events relate directly to individual supporters, and record such
activities as telephone calls, or a career history including degrees and
promotions. Individual events are only assigned from within a supporter’s

record. From either the Overview screen (&58), or the Events/Codes

form (&59), you can add, edit or remove event codes (&57).

��� 6HOHFWLRQV�RI��5HFRUGV
Selection has a whole menu of options. Some select temporarily, others
enable you to build a series of more permanent selection criteria which will
make your day-to day operation of the database fast and accurate.
The current selection is the set of records which you see on the screen.
The highlighted records are those that you have selected with the mouse.
Finally there is a memorized selections, a selection which can be
exchanged with the current selection, and which is remembered by the
database.
These temporary selections change often and are influenced by the many
actions you perform on the database, they are not a permanent grouping of
records.  For permanent grouping use one of the following:
n Assign a code to the highlighted selection
n Assign a group event to the highlighted selection
n Apply a relation to the records

����� 0DNLQJ�D�KLJKOLJKWHG�VHOHFWLRQ
The following allow you to highlight a group of records and make them the
current selection and vice versa.

G Once you have a highlighted selection, the rest of the databases
will follow suit. For example, if you have highlighted 5 supporters
then click the Donations button, only donations (if any) made by
those 5 people will be displayed.

1. Highlight all records:
q Click Select All from the Edit menu.

2. Highlight a number of records for selection:

q Highlight the first record in the database list
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q Hold down Ctrl and click the mouse on another (non-adjacent)
name to build up a non-consecutive list OR

q Move down to the last person to be selected and hold down Shift
and click the mouse to highlight all the records in between.

3. To show the records which are highlighted and make them the
current selection:

q Then click Show Selection on the Selection menu to organise
the on-screen display to contain just those records.

4. Revert to all records:
q Click Show All on the Selection menu.

5. Deselect a record and leave none highlighted
q Hold down Ctrl and click left mouse button.

����� 1DYLJDWLRQ�ZLWK�VHOHFWLRQV
With highlighted selections one can rapidly find related data.  For example
given a selection of people on the screen which is highlighted, moving to
the donations table will show these people:
1. Look at one supporter’s donations :

q Highlight the person on the database list

q Click the Donations  button on the Toolbar.
2. To find Codes, Events or Relationships belonging to a group of

people:

q Highlight the people

q Move to the Codes, Events or Relations table.

��� $GGLQJ�D�GRQDWLRQ
Donations must always be attached to a supporting contact record.
Anonymous donations should be attached to a default “anonymous”
supporter record.
There are two halves to the process of recording a donation. The first stage
attaches the promise of, or fact of, a donation to the supporter’s record. The
second stage uses the financial menu options to record the actual receipt of
the donation, or an installment.

q Open the supporter’s Quick Entry screen

q Click the Add Donation button

q Enter the donation details in this subscreen (&55).

q Leave the appeal field blank.

q date of gift, date of first payment, frequency, type of gift and
installment are mandatory fields.  Others are optional. The database
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tries to enforce these, but you can enter wrong gifts at the moment,
though not without ignoring a serious warning.

 Apart from entering crucial data, it is important to realize that the British tax
system requires you to gather forms for your donations from the donors:

q Gift aids require an R190 and covenants an R185 after one year of
payments.R185. The gift aid forms should be in your possession when
you enter the gift aid, so the boxes are ticked “yes” by default.  For
covenants the handling of forms is discussed in the section R185
handling.

q If this is the case, click the appropriate checkbox to tell the system that
the form relating to this particular gift has been received. The database
will request the forms automatically and indicate that they have been
requested.

q If your supporter has specified that all or part of this donation is to be
earmarked, enter the earmark details now in the earmark window area:

q Click that area’s button

q Select the earmark code from the pop-up list

q Enter the percentage of this donation which is to be assigned to the
earmark.

q Repeat the earmarking if the donation is to be split.

��� $GGLQJ�WUDQVDFWLRQV

At some point, you will want to record the fact that you have actually
received the money which was earlier entered as promised. Confirmation
will be in the form of cheques, or cash, or credit entries on your bank
statement. Sometimes the money will accompany the donation promise: an
unsolicited cheque means that you can enter the donation promise and the
transaction at the same time. At other times, the money will follow much
later, usually in regular instalments over a number of years.
Is in the wrong place.  Gift aids are donations not transactions.

I When entering gift aid:

q Do not confuse the date of the gift with the actual payment
date;

q Enter the total in the instalment field.

q The database will automatically fill in “annually” for the
frequency.  This is done to indicate that a gift aid makes a
single payment in the year it is made.
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G If you make a mistake, either cancel the record (&65) or move

back up the window (&51) and overtype the field with the correct
details

����� (QWHULQJ�EDWFKHV�RI�UHFHLSWV�

G If you are entering payments which have been made straight into
your bank account, check the references shown on your statement
- the Gift Number ought to be part of the reference, to aid quick
entry of moneys received.

If you already know the Gift Number, or the Name of the donor:

q From the Data menu, open the Transactions option

q OR

q From the Finance menu, select Entry by Code if you know the gift
number, or Entry by Name if you know the donor’s name.

q Enter the details of the donation.

q Save (&52) the screen.

I If you are entering a batch of donations the system does not
update each one as it is entered, for performance reasons. So,
you must

q Run the Update Donation routine from the Special menu

q Then run Update Accumulated amount

G If you are offered a further blank data window when you have
finished, click the Cancel button to close it.

����� (QWHULQJ�DQ�LQGLYLGXDO�UHFHLSW
q Highlight the person from the People screen

q Click the Donations button from the Toolbar - this gives you a list of all
the existing donations for that person

q Select Full Detail screen from the Input field

q Double-click the relevant Donation to open the Full Detail screen.

q Click the  button just below Transactions to open the transactions
detail entry screen;

q Enter the details;

q Save (&52) the screen.
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Alternatively: double click the person, using the “Overview” form.  Highlight

the relevant donation in the included list.  Click i.  Now click + just below the
transactions.

4 On a regular basis, to suit your own procedures, print a Journal
of transactions for the period. The following assumes a monthly
report:

q Select Show All from the Selection menu

q Open the Search Selection option and, against the transaction date,
key in a selection statement which identifies the starting date for the
report. For example, if you want the report to start with transactions
entered between 1st and 30th April 1997, your selection statement would
be >31/03/97 (greater than 31st March)

q Now repeat this to enter a selection statement which defines the end of
the range <02/05/97 (meaning less than 1st May)

q Having set the start and end dates, select the Print Journal option from
the Finance menu.

Again, this should not be in the transactions section but in the gift section.
Retrieve details of a Donation
You may need later to record the fact that the donation’s associated R190
or R185 has now been received. Or you may have another reason for
wanting to retrieve a donation’s details.

q Use the most appropriate of the above routines to open the Donation
screen;

q Highlight the donation whose details you want to investigate or update;

q Click the  button to expand the details.

q Make any necessary changes, and Save the details.

��� 'HILQH�DQG�VHW�XS�UHODWLRQVKLSV
You can link parents and children, or married partners, or employers and
employees, or clubs and members, or members of your board of trustees,
through the relationship link in Fundraising Pro.
This is useful if you want to select supporters who are also members of
another local charity, for example, or if you want to personalise telephone
conversations by referring to other members of the family.
First you have to define the relationship pairs. Then you select the pairings
and apply the relationship code.
Defining relationships
q Select the Relationships option on the Data menu
q Key in the text which describes the first half of the relationship
q Key in the text which describes the second half of the relationship
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q Save (&52) the details.

Applying relationships (Parent/Child is the worked example here)

G
Relationships can only be built between existing records. Do
ensure that you have records for both “halves” of the relationship
before you start.

q Click the  button to display all records in the people database;
q Find and highlight the record of the Parent;
q From the Selection menu, select Memorize Selection and confirm that

you know you have only selected one record;
q Scroll through the database list and highlight the Child;
q From the Record menu, select the Enter Related option;
q Select child from the list of available relationships.

����� 9LHZLQJ�UHODWLRQVKLSV��IDPLO\�RU�JURXS�

q Highlight a supporter’s record (or an employing company’s record);
q Open the Relations option from the Data menu;
q Scroll through the displayed records.

G At any record you can open the Relations option again and track
that supporter’s relations.
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�� )LQDQFHV�ZLWK�)XQGUDLVLQJ�3UR
In this chapter we discuss the financial aspects of Fundraising Pro

��� 6ZLWFKLQJ�WR�FRPSXWHU�WD[HV
The database can produce tax returns for gift aid and covenant donations.
To produce such returns there are two issues to be considered:
1. Donations and bank transactions entered from their first payment

onwards into Fundraising Pro.
2. Importing existing donations on which tax has been claimed already and

continuing to claim with Fundraising Pro

The first case is easy: just follow the check lists for donations in this manual
and enter transactions according to the check lists.  When the donations
are ready to be taxed the database will produce the right forms.
Taking over existing donations in Fundraising Pro is more work.  Before the
first tax run of the database can be used, it is necessary to manually make
sure that the records which are held in your books are transferred to the
donation and transaction files.
Of course this is done with the target that the database knows exactly what
has been claimed already so that it will not claim things which have already
been claimed by your accountant.
Checklist for setting up existing covenant donations for computer taxes:
1. You must start by entering all the donors and the donations that you

want to process, into the database. Start dates, end dates, installments,
and so on, must all be entered. Mark the donation active if tax is still to
be claimed for it. To do this follow the instructions for entering gifts on
page...Next you will need at least one full year of bank transactions
before the date of your first computer tax return to be entered in the
database. If the database has bank information that does not go a full
year back it will think that payment are missing and you will not be able
to claim tax. You must also correctly mark the bank transactions as
claimed when they have been. Forgetting this will cause errors. The
transactions are entered most easily as follows:
� Make a list of the donations you entered in 1) and their gift numbers
� Go to the transactions table (DATA-> Transactions) and add records

by selecting the fully editable form (finance user or administrator
access only).

� After entering the gift number and pressing tab the name and
installment will pop up and can be verified against your list.  Enter the
correct date and tick the claimed box if appropriate.

� You will find it handy to make a report of payments sorted by gift
number and date.

 
2. Go back to the donations list.  Use the master layout and enter data on

the tax tab card.  You need to enter the following fields:
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� Fill out the boxes forms sent and received. This applies to R185
forms.  Sent should be ticked if you have requested the donor to fll
out an R185 (after receiving one year’s worth of payments).
Received must be ticked if the donor has returned the form to you
after signing.

� The first claim box: tick if the first claim on the donation still has to be
made

� The date of the latest payment claimed box, must be set to the
correct date.  You can find this among the transactions you have just
entered. For a first claim, when the tax forms received box is already
ticked, set this field to a date just before (say 5 days before) the first
payment arrived, or will arrive

� The number in the latest claim (how many transactions made up the
claim) is not important, nor is the amount of the latest claim.

� The latest tax date, must be set to the date when tax was most
recently claimed for the donation.  You find this on your tax returns.

Checklist for switching to computer taxes for existing gift aid donations:
1. Enter the gift aids on which tax still has to be claimed.
2. Enter payments (these should be received with the gift aid form).

Taxes should automatically be right when due.

Once you have entered all the initial setup information, you can start to use
Fundraising Pro on a daily basis.

��� 3URGXFLQJ�7D[�FODLPV
The options for checking and claiming tax refunds from the Inland Revenue
are all contained in the Finance menu, which has highly restricted access.

q Log in as Finance User. You will probably run most of the options from
the Control Panel, without opening the database.  However, when
details need to be adjusted in donations the database will need to be
opened.

The options on the Finance menu enable you to:

� Record incoming payments&75

� Record forms which have been requested&74

� Record their receipt when returned to your organization&78
� Check donations for inconsistencies just pull the menu item “Test

covenants/gift aids/pledges”. Covered below.
� Prepare returns for the Inland Revenue; covered below.

From the Finance menu, one works through the following options:
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� Gift aids: &84
� Check Gift Aids.
� Gift Aid Tax

� Covenants&89
� Check Covenants
� Process R185
� Covenant Taxx

� Check Pledges

��� 3URFHVVLQJ�*LIW�$LG�WD[HV

G FRP takes account of the fact that the tax rate which applies to
gift aid and company covenants is dependent on the date of
receipt of the payment, or the expected day of receipt as
applicable. See the tax rate setup list.

q Covenants and gift aid tax refunds can only be claimed when you have
received confirmation from the supporter that tax has actually been paid
to the Inland Revenue, in the form of an R190 or R185 form.  If the
R190 form has already been received, the appropriate checkbox in the
donations screen should have been ticked.

G You need to log on as finance user to access the Finance
menu options.

G Make sure that your Transactions entries are up to date.

Make sure that no-one else is using Fundraising Pro.

< The routines in this checklist modify a large number of records.
Make a backup now, in case you make a mistake.

À Decide the date on which you want to claim your tax refunds. You may
make up to 4 claims per year on a quarterly basis.  The end of the
financial year for the Inland revenue and for your organisation are two
natural choices.

À Run the Check Gift Aid option from the Finance menu, entering your
chosen date. This routine then:

 

À Finds anomalies or errors in the gift aids.:
À If there is a problem with a gift aid it will determine if the payment

amount is incorrect, if the date of payment is right (in particular it
will tell you if the payment date was received before the date of
the gift in which case you cannot claim tax. It will also check that
only one payment was made.
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À If something is wrong the anomalous tick box will be checked,
and an expalanation (in text form appears in the anomaly box).

Correct anomalies: For this you open the database and use the master
form to access donation details. The anomaly is printed as text and gives
and indication what might be wrong.
Wrong number of payments

q This can happen in two cases:
1. The payment is missing. Contact the donor.
2. There is more than one payment.  Try to convince your donor to

make out a second gift aid for the date of that payment to cover
that accidental payment.  Create new gift aid donations with new
gift number for every payment received, as recorded in the
transaction file. It is irrelevant whether the bank actually uses
these codes or not. There must be precisely one payment and
one bank code for every gift aid.  Un-tick Tax form boxes for the
new gift aid donations until you have the forms.

q Use Master View for Donations to clear the anomaly box.
Wrong amount has been paid

q This usually involves writing to the supporter;

q Use  Master View to reset the anomaly after the gift has been
modified;

q Make sure that the R190 is for the correct amount.
Payment date is wrong

q Remember that the system allows a 30-day margin;

q Do not correct dates in the transaction database unless they are
really wrong (you can find the payment date from the bank
statement);

q Correct the first pay date on the donation form, and click the re-
compute button, to recalculate totals etc.  Use the re-compute button
on the Master form (Marion look at those forms in the data base!)

q Clear the anomaly Use the mouse to de-select the box.

q If the date is badly wrong, request a new R190 to avoid trouble with
the Inland Revenue.

Now repeat the Check Gift Aid routines. Usually most anomalies can be
helped away easily and a few stay.

Now run Gift Aid Tax to prepare your tax return
�  Finds Gift Aids for which the R190 has not been requested, and print

request letters;
� Finds Gift Aids for which the R190 has been requested, but not returned.
� Identifies those payments which have arrived accurately before the date

of the tax return;
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� Prints out a list of the claims so that you can attach the R190s to the tax
return;

� Prints out an R68a gift aid insert;
� Flags all those donations for which tax has now been claimed with

correct tax dates etc.;
� Marks those donations as inactive.
� Marks the transactions as claimed.

q Send off the completed R68 GA insert and any associated R190s.
Together with your R68

I Leave donations with missing forms, or anomalies, until the next
tax claim.

On the whole if anything goes wrong during the tax processing, NOTHING
will be recorded in the database and you can start afresh.
All actions the tax routines take are recorded in the tax records table.
Investigating this table will show you what has been done for any donation
to date.

4 You can investigate tax claim and reprint tax claims:

q Open the Tax Records option from the Data menu;

q Search for all records with the date and time of the tax claim,
and the ga tax claim as their action;

q Click on the Printer button on the Toolbar, or select Print on
Layout from the record menu;

q Select the R68 layout for printing..
 This routine can be used to re-print; if you have lost your old copy if your
printer jammed during your tax return etc.
To Undo taxation:

q Look in the tax records table using the Data menu to see what was done
on the date of the return you wish to undo;

q On the main Donations control screen, change the inactive flags back to
active for all donations on which tax should have been claimed but was
not.

q  Find all transactions that were claimed and mark them as not claimed in
the transaction table.

This will enable these donations can be picked up in the next tax claim.
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G FRP takes account of the fact that the tax rate which applies to
covenants is dependent on the due date or date received of  the
payment.(This is a subtle difference between company and
personal covenants)

Covenants and gift aid tax refunds can only be claimed when you have
received confirmation from the supporter that tax has actually been paid to
the Inland Revenue.

q If the R185 form has already been received, the appropriate checkbox in
the Add a Donation screen should have been ticked for each donation
for which the R185 has been returned. You should also make a copy of
the R185.

G You need to log on as finance user to access the Finance
menu options.

G Make sure that your Transactions entries are up to date.

Make sure that no-one else is using Fundraising Pro.

< The routines in this checklist modify a large number of records.
Make a backup now, in case you make a mistake and ran the
taxation for the wrong date or something like it.

q Decide the date on which you want to claim your tax refunds;

q Run the Check Covenants option from the Finance menu, entering
your chosen date. This routine then:

q Runs the Process R185 routine from the Finance menu and mail out
the R185s to the supporters concerned.

q Contact those supporters who do not return their R185s. A list is
produced by the R185 menu item:

q Go to the tax records table. Search and highlight all the records
related to the R185 mailing on the selected date.

q Move to the people table.

q Do a mail merge and label print for this selection of people

q Use Check Covenants from the Finance menu to check for anomalies
and remove as many (see below) as you can.

q Having run the Check option, find the incorrect covenants by
doing a search where

q type contains covenant

q active is true

q anomalous is true
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q Correct the anomalies as far as you can

q Run Check Covenants to check that you have fixed the anomalies -
this routine will only work on the selection of donations visible on the
screen.

q Run the Covenant Tax option from the Finance menu

q Request R185s for company covenants (which have to be
attached to each tax return) - a list is produced automatically with
the tax run.

q When the company R185s have been received, attach them to
the return and send it to the Inland Revenue

q Check for anomalies regularly by running Check all Covenants and the
Check Covenants options, on appropriately-selected covenants, from
the Tax menu.
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Before doing taxes and forms you must run a Test covenants menu item.
This checks all your donations which are active for numerous problems
such as missing payments, wrong amounts, wrong dates, overpayment etc
and prints a report which enables you to take action.  It also marks gifts are
anomalous and excludes them from tax claims to ensure you only claim on
fully valid covenants, not of problematic ones.
It goes through all transactions associated with a covenant and finds out if
all the amounts in the (transactions) equal the (donation) instalment.
Otherwise anomaly wrong payment is noted.
The data base then checks if the dates on which payments were received
are right.  If not, they are reported as such.
Test if the number of payments between (donations) tax*last*clmd and
tex*date is correct, and if they arrived on the correct datesIt will not check
this for covenants on which no R185 has been received . If anything is
wrong the anomaly reads wrong date or amount of payments.  .
Overpayments are detected and reported as such.

Dealing with the R185s

Remember: R185’s should be filled out and signed by donors after one year
of payments has been received for a covenant.
From the control panel the Finance user can claim R185 forms.  First Run a
covenant check, then pull process R185 from the Finance menu.
First the database finds out which covenants need to be processed
because a first  annual amount has been received. It then prints a list of the
gifts for which the R185 should be requested and prints the forms. After it
prints this, it sets the filed “tax form sent”  to True, since it assumes that
R185s have been mailed
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When R185’s come back to your office, you must manually tick the box
“Form Rcvd” for each applicable donation. Clicking this box sets the date of
the latest payment claimed field to a date before the first payment arrived.
This is for internal reasons.
In the tax run Fundraising Pro  only considers donations for which the tax
form was received by the development office, which is a fact to be recorded
in the database when the R185 is returned by the donor to the office.
A side effect of R185 processing is that you are notified of any R185 forms
which have not been returned to your office.  You should contact the
donors.
Which covenants are processed for taxation?
Of course they should be active and not anomalous. During the tax
processing a list of donations is produced with first claim is true, and form
received is true.  meaning that the Inland Revenue has not yet received the
R185 but the form is available in the office. It is to be attached to the first
return. When this is done the DB marks the box first claim false, so that
next time the claim is made without an R185 attached to the return. (Except
for company covenants which are handled separately)
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G Anomalies in covenants which are not active are not checked.

G It is possible for more than one anomaly to occur in a covenant.

G Make sure that foreign donations are not covenants - they should
be pledges.

G Do not forget to correct data in the transaction database if
anything is wrong with the payments there.

q Look at the donation

q Find the problem

q Correct the data in donations or in transactions.

q De-select the anomalous box in the Donation form

q Test the donation again for anomalies

����� &RUUHFWLQJ�DQRPDOLHV
Wrong
amount

payments are for the wrong amount
see the gift aid section.

Wrong
amount or
wrong
number of
payments

wrong amount of money received in a given period
You may not be able to solve this type of problem without
contacting the supporter, and your covenant may remain
anomalous for a little while.

q Check the amounts and dates on the payments.

q If the amounts are wrong, clear it up

q If payments are missing, try to recover them
 

q This code can also occur if the payments arrive
considerably off the expected date.

q In that case change the dates on the transactions
screen to make the date acceptable to the system!

q After clearing the problem, de-select the anomaly box
in the donations screen and wipe out the code

Any tax not claimed in the current run is not forgotten; the
system will pick it up next time.

Covenant payment continued after the final date
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overpaying q Create a new donation, with a new bank code

q Make sure that the transactions which are
overpayments are given the new bank code

q Remove the anomaly from the original donation. This
should now be ready for tax processing

q Ask the supporter to fill out a new covenant form and
give new start dates and amounts and final dates for
the “new” donation.

q When this has been received, mark the donation
active, and this will become a valid new covenant.

q Sometimes your donor will want his money back, or
will want to stop the overpayments immediately, in
which case you will be left with a single gift on which
you probably cannot claim tax.

�� *XLGH�WR�WKH�PHQXV
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Open Database File menu

This brings you to the data from the control panel or from a splash screen.
The administrator must use this menu to get to the data when first logging
on.

Close Database File menu

This menu item closes the data windows and brings you back to the control
panel.
The finance user must use this menu when she wishes to run taxation
routines (which are only accessible from the control panel) after having
edited the donation details.

Change Access File menu

This routine enables you to change your type of access to Fundraising Pro
(from administrator to finance, for example) without logging out and in
again. You will need to know the appropriate passwords to do this.

Printer Setup File menu

This is a standard Windows menu item which allows configuration of the
printer.
You can set paper sizes and preview on screen options. The details of this
menu vary with your printer.



59

New Data Window File menu

This menu option may or may not be present in your version. It opens
further scrolling lists allowing access to the details in the tables.  This can
be very handy to use when a phone call comes in and you do not with to
disturb carefully created selections.

Export Data File menu

Use this option whenever you need to export data to anything other than a
mail-merge letter; spreadsheets and word processors, for example, or to
other files or archive media.

q If you have already saved a particular set of selected fields as an export
template, click the Load button to activate the template.

q Select the table you want to export from.

q Select the fields to be exported using the Append button. If you forget
fields you can remove and insert them. The other buttons work in the

same way as in the Sort screen (&111).

q For any highlighted field, select a filter if you want to translate or
transpose data during the export routine; for example: the

q mm/dd>dd/mm translator would transpose month and day.

q Also, when exporting text fields which contain carriage returns (multiple
lines of an address, for example) use a translator on the field to translate
the <CR> character to another character and thereby prevent it being
confused with record separators.

q Specify your delimiters as ASCII Character 9 (Tab) for End of Field, and
ASCII Charcter 13 (Carriage Return) as End of Record.

q Tick the checkbox if you need to include the field names themselves to
be exported as a header row (to a spreadsheet, for example).

q Tick the Add linefeed checkbox if exporting to a Windows application,
since the linefeed is expected by Windows applications. Windows
applications have a carriage return and a linefeed character before a
new line starts.  Macintosh computers have only a carriage return and
Unix computers only a line feed character.

q You can Save your selection parameters as a template, so that you can
use it again whenever you need to.

q Export the exported data file as filename.TXT.

Import Data File menu
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< Make a backup before importing data into any existing files. With
this operation you make large scale modifications to the database.

You can import data to update any of the fields which form part of a
supporter’s record, including your own customised fields, in very much the
same way as described in the Export Data routine.

q When you have completed your configuration, click Import, select the
file from which to read, and click OK.

q You can use templates as in exports.

Quit File menu

When you quit the software, remember that the layouts which you have
been using this time will be not be offered as a default next time, unless you
pull the menu item, Save default views.

��� 7KH�(GLW�PHQX

Edit menu Edit menu

The Edit menu offers the standard Windows™ utilities.
Undo, cut, copy, paste allow for quick text editing.
Select All selects all of whatever you are working within at the moment
(people, or donations, or a subset of those). This can be very useful to
select all records listed on the screen.
Show Clipboard displays your most recent cut or copy.

��� 7KH�'DWD�PHQX
The data menu allows for navigation from one table to another.  Here we
discuss the navigation to some tables which have not yet been discussed
extensively.

Tasks - Set up Reminders Data menu

You can use the Tasks option on the Data menu to set up reminders for
yourself or someone else.

q Click the  button to add a new task;
q Select an action type (the popup box will be customizable in a future

version)
q Leave the letter id field blank, unless you wish to link this to a 4D Write

letter.
q Leave the record_number blank unless you wish to link the task to a

person.
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q In the who field, key in the FRP login name (office head, for example),
to ensure that on startup outstanding tasks are listed in the control
panel.

q Key in a summary (max 25 characters) and description.

Letters Data menu

The Letters option on the Data menu is only used in conjunction with 4D
Write. You can enter letters like you enter records in other tables.
The letters are usable from the letter menu itself and also from the
MailMerge and Correspondence views in the people table.
You can save a lot of time familiarizing yourself with 4D Write as a
mailmerge tool.

Codes Data menu

Codes are used as a way to group records which have something in
common, so that you can select those records from the whole database
and work just on them.

G
This can be a very powerful feature. For example, you may soon
know which people like barbecues, and which like chamber music -
and they may not be mutually exclusive! If you group similar
supporters in one Code, you can select them later and invite just
them to the next barbecue. This is more flexible, and less
cumbersome, than just assigning the barbecue event code to all the
people invited - some of them won’t turn up, and your target
audience is diffused.

Codes can be applied to Donation records as well as People records.  The
same codes are used, but the code log is separate.
The Codes option enables you to list, print or modify existing codes, as well
as adding new ones.
Assigning a new code:
q Select the Codes option from the Data menu;

q Enter your new Code  (maximum of 6 characters);

q Key in a summary (max 25), and a description (scrollable text), both of

which will be used in the popup window invoked when you click the 
button to investigate this code from anywhere else in the system.

q Save (&52) the details.

Or:
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q Highlight some people or donations

q Select “Assign Code” from the Selection menu

q Type the new code in the entry box.

q When prompted add the summary and details.

Retrieve a Code list and search for records with that code:
q From the Data menu, open the Codes option;

q Highlight  the Code you want to retrieve;

q Then from the Data menu, select the People option (or click the People
button on the Toolbar);

q Only those people who have the code the Code will be displayed.
or

q From the Search menu, select the Codes Search option;

q Select the list you want to retrieve;

q Only those people who match the Code will be displayed.

You can display selected Donations in the same way.

����� 7ULFNV�ZLWK�FRGHV�
1. When searching for a code you can use wildcards
2. It can be very powerful to use related codes for example:
tag a group of people with the code invite. When responses come in
change the codes on the se people to one of the following:
n invited (for declined)
n invetea (accepted)
n inviteaws (accepted with spouse)
n inviteawf (accepted with family)
Searching with wild cards let’s you retrieve all invite@ codes, or just the
accepted: invitea@

Code Log Don Data menu

Code Log and Code Log Don contain pairs of record numbers and code to
register that a code is linked to a certain record.

��� 7KH�5HFRUG�0HQX
Find or Add Record menu

Quick find which adds a record if not found. For large volume phone
answering work for example.
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Delete Selection Record menu

To delete records from the database there are two options:
n Delete them one by one, by double clicking and using the trash can

button
n Delete a group of records in one blow.  You must go in as administrator.

Highlight the records (in any table) you wish to delete. Then use this
menu item. (Administrator only).  This can be used to delete large
amounts of records. Use with care

Quick Report Record menu

You can use this option to design your own report layouts. It is similar in
layout to packages like Crystal  reports, but fully integrated with Fundraising
Pro. Detailed information on using this option is contained in the User Guide
which accompanies this software. All visible records will appear in the
report.

Print Layout Record menu

Certain reports are difficult to make.  For examples an R68 tax form does
many calculations.  Such pre-formatted reports are accessible through the
Print layout menu.
Most notably you can print:
n transactions as in a journal from the transactions table
n tax records of all sorts from the Tax Records table
n By searching for tax records associated with specific donations on a

certain date, you can reprint old tax returns etc.
n In donations some overviews of income can be reported.
People has a few reports too. All visible records will appear in the report.

Labels Record menu

Prints labels for all visible records. Detailed information on using this option
is contained in the User Guide which accompanies this software.

Mailmerge Record menu

A tutorial introduction to this menu is in the quick tour of Fundraising Pro
manual.
This is where you export  the records to be involved in a merged letter.
Remember, selections can be built by highlighting, searching, or using the
code or event searches.  Finally selections can be built by first highlighting
records in another table and then moving to the desired table (see the
selection menu discussion).

q Select Mailmerge from the Record menu.
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Then open your Word Processor and work the merge from within it.

G
This method only exports the following pre-determined fields from the
FRP database to your word processor:  postname, salutation,
pref_forename add1, add2, add3, town, county, country, postal
code.

G If you are using Microsoft Word, and you experience difficulty reaching
the exported data, then you must confirm the conversion when opening
the data source with the mail merge tool.  This option appears at the
moment that you select the file to which you exported for your mail
merge. (this may involve changing some of your Word Tools Option
defaults) and open the document as a text file.

A more flexible mailmerge can be achieved by exporting more fields:
q Select the records as before;

q Use the Export Data option (&97) to identify the fields whose contents
are to be merged.

q In the word processor, identify the export file as your data source for the
merged letter.

Apply Formula Record menu

You should only use this option if you are familiar with the 4D programming
language. Detailed information on using this option is contained in the User
Guide which accompanies this software.
With this option you can change large amounts of records in a
programmable way.

Search by Formula Record menu

This allows you to search for a range of records which contain a particular,
know, formula. Detailed information on using this option is contained in the
User Guide which accompanies this software.
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Here is an alphabetical list, and contents description, of all the standard
report titles available from the various menus:

You can also use the Quick Report Writer (&104) option on the Record
menu to design your own report layouts.

On pages & Error! Bookmark not defined. onwards, you will find a list
of field names and tables which will enable you to define customised
reports.
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Swap Current and Memorised

Swap current and
memorized

Selection menu

Event Search Selection menu

Find all records with a certain group event.
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Add Event
See page 108.

Add to Memorised
If you are currently working with a selection of records and you realise that
you need to add more:

q Memorise (see below) the current selection;

q On the displayed list, find and highlight those you want to add;

q Click the Add to Memorised option on the Selection menu.

q To see the amended selection, use the Swap (see below) option

q See also Omit below.

Assign Code
Sometimes you want to be able to group records permanently, rather than
the temporary grouping which is available through the Memorise (see
below) option. Records which are part of such a Code grouping retain that
code so that you can identify the records later, and repeatably.
The codes themselves are defined in the Codes (&101) option of the
Data menu.
q Select the records which you want to be part of such a group
q Open the Assign Code option from the Selection menu
q Select the Code which is to be assigned to this group

G
When working within such a Code selection, you can
temporarily restrict your selection even further, using the
Memorise options.
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I
This is not the same as a selection template of the kind Mentor
users are familiar with. It is more like a Saved List, and includes
specific records, rather than specific selection criteria. Such
lists can be useful, but will not include matching records added
to the database since the Code was originally applied.

4 Use the Code Log option to see when the code log was
created, and which records have been assigned to each code.

Code Search
Enables you to retrieve those records which have been grouped under a
particular Code template (see Assign above).
Event Search

This allows to search for records which have specific events attached.

Memorise Selection
Use this option to keep a selected set of records temporarily available, so
that you can swap (see Swap below) between the full set of records, and
this subset. The selected set of records is only memorised until you quite
FRP, or until you select and memorise another set of records.
Omit from Memorised

If you are currently working with a selection of records and you realise that
you need to remove some:

q Select All to highlight the whole subset;

q Find and highlight those you want to remove;

q Click the Omit from Memorised option on the Selection menu.

q To see the reamended list, select the Swap option (see below).
See also Add above.

Remove Code
Enables you to remove Codes which have been defined under the Assign
(see above) option.
Remove Event

This acts like Remove Code.

Show All
This option cancels any selection which you may have imposed on the
database records, and makes the whole set available again. The top left-
hand text will change to remind you that you are again working with the full
set of records.
Show Selection
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When you have identified (either by highlighting, or using a selection
template) the records which you want to work on, click Show Selection to
restrict your on-screen display to just those records. The text at the top of
the screen will change to remind you that you are working on just a few of
the available records.
Swap Current and Memorised

This option enables you to swap between the full set of database records,
and a subset which has been temporarily memorised (see Memorise
above).

See the associated User Guide for further details.

Sort Records

The sort button  allows you to specify the order in which you want your
current records (people, donations, or whatever) to be displayed. The Sort
option on the Search menu allows you to build a nested set of sort criteria.
For example, you could sort first by postcode, then within each postcode
area sort by surname.
See the associated User Guide for full details.
A brief summary
q In the left-hand window, highlight the field which is to be your broadest

area of sorting (postcode, in the above example)

q Click Append  to move it to the righthand window

q Continue to append fields, in reducing order of priority

q You can Save this sort order so that you can Load it later.

Insert a new sort field in the middle of your list of fields:

q Highlight the new field in the left-hand window;

q Position the cursor in the right-hand box on the field above which your
new field is to be inserted, then click Insert

Remove a sort field

q Highlight the field in the right-hand window and click Remove.

Reverse the sort order for one or more elements

q If you use Down or Up to specify ascending or descending order, notice
that the Down Up buttons apply to each field in the list.
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Search All Search menu

Search all brings up a form for searching, or brings up the search editor.
Details of using these can be found in the user guide under the chapters of
Search Editor and Search by Layout.

Search Selection Search menu

This performs the search in the visible selection (the current selection) of
records. It refines the selection and does not search the whole database.

Repeated Search Search menu

This option offers you a short cut to building a sub-set of dissimilar records.
Instead of having to save, memorise and add each record to the selection, it
offers you the find box immediately, until you have finished selecting. Press
the Cancel button (or hit Esc) when you no longer wish to search for more
records.

Quick Search Search menu

The Quick Search button (a magnifying glass on the toolbar) enables quick
searches based on record number, surname, initials or last contacted.

q For example, if you key DOLPHIN in the surname field, the system will
display all the DOLPHINs on the screen.

q You can just type the first few letters for a partial search.

q Or you can use the < (smaller than) or > (greater than) key followed by a
partial name, to restrict the selection to all surnames (before) or (after)
that name.

q Or use an @ as a wildcard and find all supporters whose name starts
with APPLE, by entering APPLE@ in the surname field.

q Click the GO button to start the search.

Searches  are not case sensitive.

More complicated searches can be carried out using other options from the
Search menu.

Repeated Quick Search Search menu

This menu item allows you to find a sequence of records.  Continue to type
names, record numbers which you wish to select until you have entered
them all. Then click “Cancel’ and the selection will appear.

Search Related Search menu
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Search related allows one to find records related to the highlighted
selection.  For example, highlight some donations, then choose Search
Related and find the Matched gifts.

Search Editor Search menu

This powerful option allows you to create search templates rather than lists
of actual records. Your selection criteria can contain fields from different
data files. The field-manipulation buttons work in exactly the same way as in

the Sort screen (&111).

q Click the buttons to display in turn all the fields from the different tables
in the system.  You can also hold the mouse down between the arrows
for about 1 sec. Then a list of tables will appear.

q Build up your selection criteria, gradually narrowing them down (for
example, Male ... under 35 ... living in GL7 1LT)

Search Editor is not case sensitive.

Detailed information on using this option is contained in the User Guide
which accompanies this software.

Check Pledges Finance menu

Pledges are periodic payments made to a charity, which are not eligible for
tax claims.  The Check Pledge menu verifies that payments are being
received and that payment is not continued beyond the last payment date of
the pledge.

Check Selected Covenants Finance menu

This checks just those covenants in the current selection in the donations
file.  This can be useful after fixing a few errors, to avoid a long running
operation.

Process R185 Finance menu

This routine:

q searches the database for covenants where the R185 has not yet been
received from the supporter;

q prints out customised R185s (acceptable to the Inland Revenue)
containing the supporter’s personal and covenant details;

q generates a tick in the requested checkbox on each donation record;

q prints out labels so that you can post the R185s to your supporters, for
their signatures;

q prints out a list of R185s outstanding from the last run.
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Gift Aid Tax Finance menu

This prepares the Gift Aid insert of the R68a form.  It also verifies the
receipt of R190 forms connected with gifts.

Update Pledges Finance menu

This menu updates the amounts received from pledges.

Graph Income Finance menu

This menu allows to graph projected income based on the selection of
donations visible on the screen.  An example is described in the Quick Tour
of Fundraising Pro

Print Actual Income Finance menu

This menu item produces a journal of transactions selected.  It is mostly run
after entering a batch of transactions, to keep journals up to date.

Export Transactions Finance menu

This menu item exports the current selection of transactions with their
ledger information to a text file.  This can be read by most accounting
programs.
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Save Default View Special menu

This saves the forms you have selected for viewing details and lists as the
defaults to be used next time you start up the database.

Swap Addresses Special menu

This swaps the first and second address in the selection.  Use this with
care.

PhONEday Special menu

This can change old phone numbers to new ones using the British Phone
day conversion rules.

Update Accumulated Amount Special menu

This updates the accumulated amounts in the donations records.  After
entering transactions it is a good idea to run this menu.

Swap Fields Special menu

This option allows you to swap the contents of two fields in your people
table. This can be handy if you have feel that information in alpha2 should



71

be in alpha5 and vice versa for example. You should not attempt to do this
without first discussing the consequences with your Project Leader.

User Mode Special menu

On multi-user installations this menu item can activate the 4D User
environment for the Administrator.  This offers further features which are
covered by the 4D Documentation coming with 4D Server.

Design Interface Special menu

This is for use during Fundraising Pro development, and this menu option
cannot be enabled by users of Fundraising Pro

Licence Special menu

This menu item allows you to enter a new license key. Make sure to have
the name of your charity and the key handy, as they appear on the license
document.

��� 7KH�+HOS�0HQX
Help menu Help menu

Use the About option to check the version of the software you are currently
using. This shows which database file you are using and which version of
the software is running.
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